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Preface

How to Use This Guide

Purpose of This
Guide

Audience

Assumptions

Text Conventions

This guide describes the function of the Process Quality Values
(PQV) for the supported analyses of the GeneMapper® Software,
explains the fundamental algorithms used by the software, and
provides basic troubleshooting techniques.

This guide is intended for trained laboratory personnel. Applied
Biosystems is not liable for damage or injury that results from use of
this guide by unauthorized or untrained parties.

This guide assumes that:

* You have installed GeneMapper® Software Version 4.1 as described
in the GeneMapper® Software Version 4.1 Installation and
Administration Guide (PN 4403614).

* You have a working knowledge of the Microsoft® Windows®
operating system.

This guide uses the following conventions:
* Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow bracket ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide \'



Preface

How to Obtain More Information

User Attention
Words

Two user attention words appear in Applied Biosystems user
documentation. Each word implies a particular level of observation
or action as described below:

Note: Provides information that may be of interest or help but is not
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control
Console.

IMPORTANT! To verify your client connection to the database, you
need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet
for each 96-well plate.

How to Obtain More Information

Vi

Safety
Information

Software
Warranty and
License

See the GeneMapper® Software Version 4.1 Installation and
Administration Guide (PN 4403614) for safety information.

See the GeneMapper® Software Version 4.1 Installation and
Administration Guide (PN 4403614) for warranty and licensing
information.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide



Preface
How to Obtain More Information

Related The following related documents are shipped with the software:

Documentation  GeneMapper® Software Version 4.1 Installation and
Administration Guide (PN 4403614) — Provides procedures for
installing, securing, and maintaining version 4.1 of the
GeneMapper Software.

s GeneMapper® Software Version 4.1 Getting Started Guides for
microsatellite analysis (PN 4403672), loss of hetereozygosity
(LOH) analysis (PN 4403621), AFLP® system analysis
(PN 4403620), SNaPshot® kit analysis (PN 4403618), and
SNPlex"™ system analysis (PN 4403617) — Five guides that
explain how to analyze the application-specific example data
provided with the GeneMapper Software. The guides provide
brief, step-by-step procedures for the analysis of microsatellite,
LOH, AFLP® system, SNaPshot® kit, and SNPlex"" system data
generated by compatible Applied Biosystems electrophoresis
instruments and Data Collection Software. The guides are
designed to help you quickly learn to use basic functions of the
GeneMapper Software.

» GeneMapper® Software Version 4.1 Online Help — Describes
the GeneMapper Software and provides procedures for common
tasks. Access online help by pressing F1, selecting Help

» Contents and Index, or clicking & in the toolbar of the
GeneMapper window.

+ GeneMapper® Software Version 4.1 Quick Reference Guide
(PN 4403615) — Provides workflows for specific analysis types
and lists instruments, software, and analysis applications
compatible with the GeneMapper Software.

» GeneMapper® Software Version 4.1 Reference and
Troubleshooting Guide (PN 4403673) — Provides reference
information such as theory of operation and includes
troubleshooting information.

Portable document format (PDF) versions of this guide and the other
documents listed above are available on the GeneMapper® Software
Version 4.1 Documentation CD.

Note: For additional documentation, see “How to Obtain Support”
on page viii.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide Vii



Preface
How to Obtain Support

Send Us Your
Comments

Obtaining
Information from
the Online Help

Applied Biosystems welcomes your comments and suggestions for
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

The GeneMapper® Software features an online help system that
describes how to use each feature of the user interface. To access the
online help, click @ in any window or dialog box (Help » Contents
and Index if available) for more information.

How to Obtain Support

viii

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

Search through frequently asked questions (FAQs)
Submit a question directly to Technical Support

Order Applied Biosystems user documents, MSDSs, certificates
of analysis, and other related documents

Download PDF documents
Obtain information about customer training
Download software updates and patches

In addition, the Support page provides access to worldwide telephone
and fax numbers to contact Applied Biosystems Technical Support
and Sales facilities.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide
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Process Quality Values
and
Basic Troubleshooting

Process Quality Values and
Basic Troubleshooting

In this chapter:

Diagnosing and Resolving Basic Problems . ............. 2
ADO (Allele Display Overflow) . ..................... 8
AE (Allele Edit) . . ... 8
AN (Allele Number). . . ...... ... i 9
BD (BroadPeak) .............. ... .. i 9
BIN (Outof BinAllele) . ....................oii.. 10
CC (Control Concordance). . ...........covvvreunn... 11
DP (Double Peak). .. ........... ..., 12
GQ (Genotype Quality) .. ..., 13
LPH (Low Peak Height). . .......................... 15
MNF (Matrix NotFound) .......................... 16
NB(NarrowBin) ................. ... .. ... ...... 18
OBA (One Basepair Allele) . ........................ 18
OS(Offscale) . ... 19
OVL (Overlap). . ....ov i e 20
PHR (Peak Height Ratio)........................... 21
SENF (Sample File Not Found)...................... 22
SHP (Sharp Peak)............. ... . ... 23
SNF (Size Standard Not Found). . .................... 23
SP(SplitPeak)......... ... 24
SPA (Single Peak Artifact). ......................... 24
SPU (Spectral Pull-Up) ........ ... ... .. 25
SQ (Sizing Quality) . .. ... vt 25
XTLK (Cross Talk) . ..., 32
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Chapter 1 Process Quality Values and Basic Troubleshooting
Diagnosing and Resolving Basic Problems

Diagnosing and Resolving Basic Problems

PQVs and the
Troubleshooting
Process

About Process
Quality Values
(PQVs)

The GeneMapper® Software has a system of Process Quality Values
(PQVs) that provide the basis for troubleshooting fragment analysis
data using the software. PQVs are application-specific metrics, where
each evaluates the data for a specific quality that is consistent with a
problem associated with the type of analysis. In this way, the PQV
system can alert you to potential problems and provide you with a
starting point for investigation.

Each individual PQV displays the result of a unique algorithmic test
that evaluates a specific property of the fragment analysis data. The
software performs the PQV tests in a specific sequence during the
analysis. With the exception of the Sizing Quality (SQ) PQV, the
software completes the analysis of each sample in a project even if a
sample fails one or more PQV tests.

The majority of PQV metrics yield numeric values between 0 and 1,
where 1 indicates that the related sample data or genotype completely
passed the associated test. Following the analysis, the software uses
the upper and lower thresholds for each PQV to translate the numeric
score into one of three symbols, displayed in the Samples or
Genotypes tab of the GeneMapper window.

Note: If the thresholds of a PQV can be customized, the software
displays the parameters in the Quality Flags tab of the analysis method.

Default

Symbol Definition Range

d . Pass: The sample or genotype passed the PQV . 0.75t0 1.0
test.

. Check: A possible problem exists for the sample . 0.25t00.75
or genotype.

0 Low Quality/Fail: There is a strong possibility that 0.0t0 0.25
a problem exists for the sample or genotype.

Note: Applied Biosystems recommends examining all samples that
produce ;% (Check) or @@ (Low Quality).

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide



Chapter 1 Process Quality Values and Basic Troubleshooting
Diagnosing and Resolving Basic Problems

Note: The Allele Display Overflow (ADO) and Allele Edit (AE)
PQVs of the Genotypes tab report their results as ¢ instead of the
colored icons.

Note: The GeneMapper Software does not complete the analysis of
samples that display @ (Low Quality) for the Sizing Quality (SQ)
PQV test.

Adjusting the Threshold Settings of PQV Tests

Some PQV metrics include components that can be customized. In
those cases, the user-defined parameters for the PQV appear in the
Peak Quality tab of analysis methods for the applicable analysis type.

Adjusting the Weights of PQV

The majority of PQV contribute to the Genotype Quality (GQ) PQV, a
metric used to gauge the confidence of each genotype call. In those
cases, some PQV contain user-defined weights that determine how
significantly the associated PQV affect the GQ PQV calculation. For
those PQYV, the user-defined weights appear in the Quality Flag tab of
analysis methods for the applicable analysis type. For more information
on the calculation of the GQ PQYV, see “GQ (Genotype Quality)” on
page 13.

Note: You can configure a PQV so that it does not contribute to the
GQ (by setting the weight to 0). However, the PQV remains active.

Rules for PQV Columns

* Quality metrics with | Pass/ * Check values and no @Low
Quality values are warning flags. Analysis does not stop if problems
are detected with these properties, but Applied Biosystems
recommends examining results flagged as ;* (Check).

* Holding the cursor over a column header displays a tooltip that lists
the full name of the column (the default names are often acronyms).

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 3
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Diagnosing and Resolving Basic Problems

Table 1-1  PQV values by application

Analysis
PQVs
- Microsatelite (?-:i % i See Page
Abb. Name 5% 2 5. &g
<® N o ny 7X7)

ADO  Allele Display Overflow v v v v v 8
AE  Allele Edit v v v v v 8
AN Allele Number v v v v 9

BD Broad Peak v v v v v 9
BIN Out of Bin Allele (4 v v 10
CC . Control Concordance v v v v 11

DP | Double Peak v 12
GQ . Genotype Quality . v v . v v v 13
LPH Low Peak Height v v v v 15
MNF Matrix Not Found v v v v 16

NB Narrow Bin v 18
OBA  One Basepair Allele v 18
0S | Off-Scale v v v v v 19
PHR | Peak Height Ratio ' v v v v 21
SFNF | Sample File Not Found v v v v v 22
SHP Sharp Peak v 23
SNF Size Standard Not Found 4 4 4 4 4 23

SP  Split Peak | v 24
SPA . Single Peak Artifact 4 24
SPU . Spectral Pull-Up v v v v v 25
SQ Sizing Quality v 4 v 4 4 25
XTLK | Cross Talk 4 4 4 8
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Diagnosing and Resolving Basic Problems

Common Troubleshooting Procedures

About the
Procedures

Displaying Sample
Information/Raw
and EPT Data

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide

Procedures commonly used to troubleshoot errors and irregularities
in fragment analysis data:

B Displaying Sample Information/Raw and EPT Data . see below
B Displaying Numeric PQV Metrics. .. ................... 7

1. In the GeneMapper window, select the Samples tab.

2. In the Navigation Pane of the GeneMapper window:
a. Click = to expand the contents of the project folder.

b. From the list of samples, select a sample that displayed
(Check) or @ (Low Quality).

3. Select the Info, Raw Data, and EPT Data tabs as needed to
display the sample information for the selected file.

 Info tab — Displays a summary of all information for the
associated sample file (see Table 1-2 on page 6).

+ Raw Data tab — Displays an electropherogram of spectral
data collected during the run of the associated sample. The
spectral data is displayed in relative fluorescent units (RFU).

+ EPT Data tab — Displays the EPT (electrical, power, and
temperature) data for the associated sample throughout the
course of the run.

Note: Table 1-2 lists only the information contained in the Info tab
that is relevant to troubleshooting. For a complete description of the
elements listed in the Info tab, see the GeneMapper® Software Online
Help.
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Diagnosing and Resolving Basic Problems

Table 1-2 Info Tab information relevant to troubleshooting

Group Description/Information
Sample Describes the source and status of the imported sample data.
Information

Error Message

Sample Origin Path — Displays the path to the associated sample file at the time it
was imported (provided that the sample was added to the project from a sample
file).

Status Message — Displays information related to any events that occurred when
the sample was imported into the project.

Displays any errors the software encounters during the analysis of the associated
sample. You can use the information in this group to verify the source of several
analysis problems.

Current Settings

Describes the analysis settings currently applied to the associated sample.

All of the data displayed in this group is useful for troubleshooting problems with
the GeneMapper Software. Although, most of the information can be viewed in
various parts of the software, the Current Settings group summarizes all the
information in a single location for easier access.

Run Information

Data Collection
Settings

Capillary
Information

Provides basic information about the configuration of the compatible
Applied Biosystems electrophoresis instrument and the run itself.

Instrument Name - Displays the name of the instrument used to run the sample.
The instrument name is important when diagnosing trends in analysis errors that
can be traced back to the instrument used to run the failed sample(s).

Data Collection Ver — Displays the version number of the Data Collection
Software used to run the sample.

Describes the configuration of the Data Collection Software at the time the sample
was run.

The data displayed in this group can be used to troubleshoot problems caused by
modifications to run modules. By comparing the Data Collection Settings
information from passing and failing runs, you can identify any changes made to
the run module (intentional or unintentional) that may have caused or contributed
to the failure.

Note: The data displayed in the EPT tab provides a log of the actual parameters
throughout the run.

Provides the basic specifications of the capillary array used to run the sample.

Capillary Number - Displays the number of the capillary used to run the
associated sample. Like the instrument name, the capillary number is important
when diagnosing trends in analysis errors that can be traced back to the capillary
used to run the failed sample(s).

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide
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Displaying By default, the GeneMapper Software displays || (Pass), ;% (Check),
Numeric PQV  or @ (Low Quality) in some PQV columns to represent the numeric
Metrics score of the associated quality metric. When troubleshooting quality
errors, it is often more useful to configure the software to display
numeric representations of the quality values.

For example, the Sizing Quality (SQ) PQV evaluates the similarity
between the fragment pattern defined by the size standard definition and
the actual size standard peak distribution pattern in the sample data. The
Sizing Quality metric yields a value between 1 and 0 that represents a
combination of statistical measures for the size calling method used to
perform the analysis. Based on the PQV Threshold settings of the
Quality Flags tab, the software displays [ (Pass), ;* (Check), or

@ (Low Quality) to indicate the result of the Sizing Quality calculation.

Sizing Quality Representation Samples Table Example
Symbols RunMame  |SFNF |SMF |05 [6@) |WELLG
(default) peEswrex |l (Il (I (H| (W

ocE_SwPie (Il (W W \.} []

Numbers RunMame |SFNF |SMF |05  [5Q) |WELLG
(recommended for troubleshooting) DGE_SWPe [ (M @ |'9] [0
DB _shPlex_| B BJ o 1o

To display numerical representations of the quality metrics:
1. Select Tools » Options, then select the Analysis tab.

2. In the Quality Metrics Display settings, select Numbers.

oo =

FF Augomaticay bring srrors b e 52 o the tacke

Guality Metrics Display

" Symbols

3. Click OK to apply the settings.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 7
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ADO (Allele Display Overflow)

ADO (Allele Display Overflow)

Description/
Function

Expected Values

Troubleshooting

The ADO PQV indicates that the number of alleles called for the
associated sample at the specified marker exceeds the Allele Setting in
the Genoptypes tab of the table setting. Because the software is
configured to display fewer alleles than are present, the data for the
additional allele is hidden from view.

Note: For each allele detected by the software, the Genotypes tab
displays six columns: name, size, height, area, mutation, and comments.

> — Indicates that the associated sample contains a number of
alleles at the specified marker that is greater than the user-defined
limit.

Select the affected genotype, click [l (Analysis » Display Plots),
then review the affected sample for miscalled peaks.

AE (Allele Edit)

Description/
Function

Expected Values

The AE PQV indicates whether or not a user modified the allele call
for the associated genotype.

Note: Allele calls can be modified in the Samples Plot, the
Genotypes Plot, and the Cluster Plot.

»~ — Indicates that the associated genotype call has been edited.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide
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AN (Allele Number)

AN (Allele Number)

Description/
Function

Expected Values

Troubleshooting

The AN PQYV indicates that the associated sample contains either:

* A number of alleles at the specified marker that exceeds the
Max Expected Alleles setting (in the Peak Quality tab of the
analysis method)

or
* No alleles are present at the specified marker

[ (Pass) or ;% (Check)
Select the affected genotype(s), click [l (Analysis » Display Plots),

then review the sample data at the affected marker for additional peaks
or for the absence of peaks.

BD (Broad Peak)

Description/
Function

Expected Values

Troubleshooting

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide

The BD PQV indicates that the width of the peak for the associated
genotype exceeds the Max peak width setting (in the Peak Quality tab of
the analysis method).

Note: When the BD PQV is triggered, the software reduces the GQ
PQV by 50% because the default multiplier is 0.5.

[ (Pass) or ;% (Check)

Select the affected genotype, click [l (Analysis » Display Plots),
then review the associated peak for irregularities.
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BIN (Out of Bin Allele)

BIN (Out of Bin Allele)

Description/
Function

Expected Values

Troubleshooting

The BIN PQV indicates that the apex of the peak for the associated
genotype is outside of the boundaries that define the associated bin.

Note: When the BIN PQV is triggered, the software reduces the GQ
PQV by 80% because the default multiplier is 0.8.

Note: For human identification (HID) analysis, the BIN PQV is
displayed as the OL (Off-Ladder Alleles) PQV.

[ (Pass) or ;* (Check)

Select the affected genotype, click [ (Analysis » Display Plots),
then review the allele(s) at the appropriate bin location.

Symptom

BIN PQV displays

(Check)

Possible Cause

After using Auto Bin to generate bins,

the software did not create a bin for an
allele peak because it considered the
peak to be a single peak artifact. The
SPA flag was triggered because the
software did not detect any stutter
peaks to the left of the allele peak; a
result of the minimum fragment length
for the marker being set too high

Solution

. Correct the SPA flag by editing the

marker minimum fragment length,
then reanalyze and perform the Auto
Bin again.

The GeneMapper Software detected
an allele peak that did not fit into any
of the defined bins because the bins
were not calibrated to the allelic
ladder; a result of a sample file
containing an allelic ladder that is not
designated as an allelic ladder in the
Samples tab.

You generated bins using the Auto Bin
function but the GQ value for a marker
was less than the Minimum Quality
Value of 0.1 (as set in the Auto Bin
dialog box).

In the Samples tab of the
GeneMapper window, set the Sample
Type of the sample containing the
allelic ladder to Allelic Ladder.

. View the allele peak(s) for the marker

in the Genotypes Plot window.
Determine if the allele peaks(s) are
valid. If so, manually create bin(s) for
the peak(s).

10
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CC (Control Concordance)

Description/
Function

Expected Values

Troubleshooting

CC (Control Concordance)

The CC PQV indicates that the associated control sample does not
exactly match the defined alleles for the related marker.

IMPORTANT! Applied Biosystems recommends running the control
sample at least once for every panel.

Note: The CC PQV serves primarily as an internal control for quality

assurance.

[ (Pass) or ;* (Check)

Select the affected control sample in the Samples tab of the GeneMapper
window, click [l (Analysis » Display Plots), then review the positions

of the peaks relative to the bins.

Symptom

CC PQV displays
(Check)

Possible Cause

. The allele calls of the sample defined

as the Positive Control in the Samples
tab do not match the Positive Control
allele calls in the marker definition
because the well contains the
incorrect positive control sample.

The allele calls of the sample defined
as the Positive Control in the Samples
tab do not match the positive control
allele calls in the marker definition
because the alleles were defined
incorrectly.

The sample defined as the Negative
Control contains an “allele peak” due
to the presence of a spike caused by
dust or a gas bubble.

Solution

Run the correct positive control and

add the sampile file to the project,
then define the sample as the
Positive Control in the Samples tab
of the GeneMapper window.

Edit the Positive Control allele calls in

the marker definition in the Panel
Manager.

Rerun the negative control and add

the sample file to the project, then
define the sample as the Negative
Control in the Samples tab of the
GeneMapper window.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 11
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DP (Double Peak)

DP (Double Peak)

Description/ The DP PQV indicates that the peak for the associated genotype:
Function * Resides in a bin with another peak of the same dye color

and
* The ratio of the peak height (minor/major peak height) is greater

than the Double Peak setting in the Peak Quality tab of the
Analysis Method

Expected Values | (Pass) or ;% (Check)

Troubleshooting  Select the affected genotype, click [ (Analysis » Display Plots), then
review the sample data at the appropriate bin for additional peaks.

Symptom Possible Cause Solution
DP PQV displays A problem with the chemistry is Check primer lengths and
(Check) causing peaks from two different electrophoresis conditions and
markers not to resolve, possibly adjust as necessary.

because either of the primers are too
similar in length or the mobilities of
the two primer fragments are similar.

12 GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide
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GQ (Genotype Quality)

GQ (Genotype Quality)

Description/
Function

The GQ PQYV provides a summary of the quality metrics for each
genotype. The GQ value is a calculated combination of the relevant,
weighted PQVs and the Marker Quality value for the genotype.

Calculation of the Genotype Quality (GQ) Metric

The formulas used by the GeneMapper Software to calculate the GQ
value are analysis-specific, and differ largely based on the PQVs
supported by each application. The following general formula
describes the genotype quality calculation:

GQ = MQx((1-BD)x(1-0S)x... x(1-SPU))

where the Marker Quality (MQ) value is modified by the user-defined
PQVs to generate the final GQ value, and the PQVs are weighted from 0
to 1. The actual value of each PQV in the equation is 1 minus the weight
assigned in the Quality Flags tab of the analysis method used to analyze
the data.

PQV Weight Net Effect on GQ Calculation

0 No effect on the GQ calculation

The initial value of 1 minus the weight of 0 yields a PQV of
1. When used in the GQ calculation, the PQV has no effect
since 1 « MQ = MQ.

1 Reduces the GQ value to 0

The initial value of 1 minus the weight of 1 yields a PQV of
0. When used in the GQ calculation, the PQV automatically
causes the GQ to fail since 0 « MQ = 0.

O<x<1 Reduces the GQ value to the fraction specified by the
weight. The higher the value, the greater the effect on GQ.

IMPORTANT! The filtering of individual PQVs is controlled by the
threshold settings in the Peak Quality tab of the analysis method.
Also, the PQVs remain fully functional regardless of the weights
used.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 13
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GQ (Genotype Quality)

Expected Values

Troubleshooting

14

Calculation of the Marker Quality Metric

Figure 1-1 shows how the GeneMapper Software generates a Marker
Quality (MQ) value from sample peak data with assigned Allele
Quality (AQ) values. AQ values are a function of quality value
assignments for: sizing quality, allele calling quality, bin assignment
quality, and bin quality.

Note: When analyzing SNPlex™" System sample data, the GeneMapper
Software calculates GQ values depending on the method (Model or
Rules) selected to perform allele calling. The following figure
illustrates the derivation of GQ values using the Rules method.

N |rra

X (AQ) = MQ

2!

GR2119

Figure 1-1 Calculation of the Marker Quality metric

[ (Pass), ;. (Check), or @ (Fail)

Note: The software assigns the GQ PQV flags based on the PQV
threshold settings in the Quality Flags tab of the analysis method.

Review the PQV for the affected genotype to determine the metric that
is causing the GQ PQYV to fail.

Note: To better determine how individual PQV contribute to the GQ
PQYV, configure the software to display the PQV numerically, as
explained in “Displaying Numeric PQV Metrics” on page 7.
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LPH (Low Peak Height)

LPH (Low Peak Height)

Description/
Function

Expected Values

Troubleshooting

The LPH PQYV indicates that the height of the peak for the associated
genotype is lower than the associated heterozygous or homozygous
height limit that is specified in the analysis method. You can set
homozygous value (default is 200) and heterozygous value (default is
100) in the Peak Quality tab of the analysis method.

Note: When the LPH PQV is triggered, the software reduces the GQ
PQV by 50% (the default multiplier is “0.5”).

[ (Pass) or ;* (Check)

Select the affected genotype, click [ii] (Analysis » Display Plots),
then review the associated peak for irregularities.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 15
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MNF (Matrix Not Found)

MNF (Matrix Not Found)

Description/
Function

Expected Values

Troubleshooting

The MNF PQYV indicates whether or not the GeneMapper Software
can access the matrix specified in the Matrix column of the Samples
tab for the associated sample.

IMPORTANT! Because recent models of Applied Biosystems
instruments save matrix data to the sample files they create, the MNF
flag is applicable only to sample files created by the ABI PRISM® 310
and 377 instruments.

[ (Pass) or ;* (Check)

Determine the name of the missing matrix file(s) by reviewing the
sample information for the affected samples, as explained in
“Displaying Sample Information/Raw and EPT Data” on page 5.

Symptom Possible Cause Solution
MNF PQV displays The software could not Locate the missing matrix file, then import it as
(Check) access the matrix file explained in “Importing a Matrix File (Windows®
specified in the Matrix Only)” on page 16
column f.o r the associated If the sample files for the matrix standards used
sample file. . : .
to create the missing matrix are available, re-
create the matrix as explained in “Generating a
Matrix” on page 17.
Importinga IMPORTANT! You must convert matrix files created by Macintosh®
Matrix File computers before importing them. The conversion utility is free and
Mindows® Only) available from the software support section of the Applied Biosystems

16

website (www.appliedbiosystems.com/support/software/).

1. Click [F (Tools » GeneMapper Manager).

2. In the GeneMapper Manager, select the Matrices tab, then
click Import.

3. In the Importing Matrix dialog box, navigate to and select the
matrix file, then click Import.

4. Click Done to close the GeneMapper Manager, then analyze the
project.
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1. Click @ (Tools » GeneMapper Manager).

2. In the GeneMapper Manager, select the Matrices tab, then

click New.

3. In the Matrix Editor dialog box:

MNF (Matrix Not Found)

a. Type a name and description for the matrix.

b. In the Number of Dyes drop-down list, select the number of
dyes present in the matrix (4 or 5).

c. Click B, navigate to and select the sample file for the blue
matrix standard, then click Open.

d. Repeat step 3¢ for the remaining dyes in the matrix (Green,
Yellow, Red, and Orange if applicable).

e. Click Create to create the matrix.

Click OK.

rMatrix Description

Matriz Mame: | Example hatrix

Size standard

JOE-greend-31-04-12-40 PM.fsa

Start At:

1
|
Description: | | name
Matrix Setting:
Select the Matrix Standard Sarnple File: Mumber of Dyes: | 4 % Size Standard dye
FAM-blUEE-31-04-11-52 AM fsa Start at. | 1000 channel

1000

MED-yelowd-31-04-1-11 PM fza
E ROX-red8-31-04-1-41 PMfsa |

Start At:

Start At:

Paints:

Fragment sizes
for the size
standard

1000

1000

100000

HEEEE

hatrix Result
B G v R .
& |1.0000 o895 1770 .0043 Generated matrix
G |0.5804 1.0000 0.5310 0.0237 data
v |oe902 03526 [1.0000 0374
R |oas71 07230 05257 [1.0000

4. Click Done to close the GeneMapper Manager.

5. In the Matrix column of the Samples tab, select the new matrix,

then analyze the project.
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NB (Narrow Bin)

NB (Narrow Bin)

Description/ The NB PQV indicates that the apex of the associated peak for the
Function associated genotype is present within 0.5 base pairs of a bin that does
not contain a peak. This PQV is designed to capture peaks that are
outside of bin boundaries because of incorrect bin definitions.

Expected Values | (Pass) or ;% (Check)

Troubleshooting  Select the affected genotype, click [iii (Analysis » Display Plots),
then review the peak at the appropriate bin location.

Symptom Possible Cause Solution
NB PQV displays You created a bin that is too narrow In the Panel Manager, edit the bin
(Check) to contain its associated allele peak. | width and/or location so that it

contains the allele peak.

OBA (One Basepair Allele)

Description/ The OBA PQV indicates, for the associated genotype, that the apex
Function of the associated peak is present at a position within 1 base pair of
another peak.

Expected Values [ (Pass) or ;% (Check)

Troubleshooting  Select the affected genotype, click [ (Analysis » Display Plots),
then review the allele at the appropriate bin location for a
microvariant peak or an invalid allele call.
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OS (Offscale)

Description/  The OS PQV is displayed in both the Samples and Genotypes tabs of
Function the GeneMapper window, but the function of the OS PQV in each tab
differs in the following way:

* OS PQYV for the Samples tab — The signal associated with the

size standard of the specified sample contains one or more peaks
that exceed the maximum detectable range.

OS PQY for the Genotypes Tab — The signals associated with
the given sample contain one or more peaks that exceed the
maximum detectable range.

Note: When the OS PQV of the Genotypes tab is triggered, the
software reduces the GQ PQV by 50% (the default multiplier is “0.5”).

Expected Values [ (Pass) or ;% (Check)

Troubleshooting 1.
2.

In the GeneMapper window, select the Samples tab.

In the Navigation Pane, click = to expand the project folder, then
select the sample that displays ;* (Check) in the OS column.

Select the Raw Data tab to display the electropherogram of
normalized spectral data collected during the associated sample run.
The spectral data is displayed in Relative Fluorescent Units (RFU).

Review the data for offscale peaks.

1} 1000 2000 3000 4000 5000 E000

e Offscale peak
6000 (primer peak)
4000
2000

1]

Use Table 1-3 on page 20 to determine an appropriate corrective
action.

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide 19
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OVL (Overlap)

Table 1-3 OS PQV Troubleshooting

Symptom Possible Cause Solution
e MNF PQV in the Samples tab displays | Too much size No action necessary. The data
(Check) standard injected cannot be manipulated to remove
 Raw data contains multiple off-scale into the capillary the oversized peaks.
size standard peaks Decrease the quantity of size

standard used in subsequent runs.
Also, make sure to use Hi-Di
Formamide as the loading reagent.

IMPORTANT! Water loading can
produce artificially high signal and
is not recommended.

¢ MNF PQV in the Genotypes tab Too much sample No action necessary. The data
displays (Check) injected into the cannot be manipulated to remove
¢ Raw data contains multiple off-scale | capillary the oversized peaks.
peaks in the signal(s) associated with Decrease the quantity of sample
the sample fragments used in subsequent runs.

OVL (Overlap)

Description/ The OVL PQV indicates that the peak for the associated genotype
Function has been called twice by the GeneMapper Software. If the ranges of
two bins overlap, a peak can reside in both bins and, therefore, be
called twice, once for each allele.

Expected Values [ (Pass) or ;% (Check)

Troubleshooting  Select the affected genotype, click [ (Analysis » Display Plots),
then review the peak and associated bins at the appropriate location.
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PHR (Peak Height Ratio)

PHR (Peak Height Ratio)

Description/ The PHR PQV indicates that the apex of the peak for the associated

Function

Expected Values

Troubleshooting

Symptom

genotype is:
» Present at a position within 1 base pair of another peak

and

* The ratio of the height of the lower peak to that of the higher
peak is less than the Minimum Peak Height Ratio setting in the
Peak Quality tab of the analysis method.

Note: For LMS markers, the ratio is calculated based on the peak
heights of the called allele peaks.

Note: For SNaPshot® kit analysis, the ratios are calculated as they
are for microsatellite markers except that they span two different
colors, and only two peaks are used in the calculation.

[ (Pass) or ;* (Check)

Select the affected genotype, click [ (Analysis » Display Plots),
then review the peaks at the appropriate location.

Possible Cause Solution

PHR PQV displays
(Check)

The sample has undergone Loss of Normal occurrence. No action
Heterozygosity (LOH). A difference necessary.

in peak heights between alleles is
expected.

Further evaluate the sample for LOH
using the Report Settings Editor and
Report Manager.

For more information, see the
GeneMapper® Software Version 4.1
LOH Analysis Getting Started Guide
(PN 4403621).
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SFNF (Sample File Not Found)

SFNF (Sample File Not Found)

Description/  The SFNF PQV indicates whether or not the software can access the
Function sample file (*.fsa) shown in the Sample File column of the associated
sample. When the software adds a sample to a project from a sample file,
it retains a link to the original file. The software displays ;* (Check) in
the SENF column if the sample file is deleted, renamed, or moved.

Expected Values [ (Pass) or ;% (Check)

Troubleshooting Determine the name and location of the missing sample file:
1. In the GeneMapper window, select the Samples tab.

2. In the Navigation Pane of the GeneMapper window, click = to
expand the contents of the project folder, then select the sample
that display ,* (Check) in the SFNF column.

3. Select the Info tab, then note the name (Sample File) and
location (Sample Origin Path) of the sample.

Symptom Possible Cause Solution

SFNF PQV displays Sample file has been Search the local drives of the computer for the
(Check) renamed, moved, or sample file, then do one of the following:

deleted. ¢ If you cannot find the file, no further action can

be taken to resolve the PQV flag.

¢ |[f you find the file, use the Associate Sample
feature to direct the software to the new
location as follows:

a. In the Samples tab of the GeneMapper
window, select the affected samples.

b. Select File » Associate Samples.

c. In the Select Folder dialog box, select the
folder containing the missing files, then
click Select.
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SHP (Sharp Peak)

SHP (Sharp Peak)

Description/
Function

Expected Values

Troubleshooting

The SHP PQYV indicates that the peak for the associated genotype is
part of a cluster of peaks with a large, narrow peak in the middle
whose width is 50% less than either of the neighboring peaks.

[ (Pass) or ;* (Check)

Select the affected genotype, click [ii] (Analysis » Display Plots),
then review the peak at the appropriate location.

SNF (Size Standard Not Found)

Description/
Function

Expected Values

Troubleshooting

The SNF PQV indicates whether or not the GeneMapper Software
can access the size standard definition specified in the Size Standard
column for the associated sample.

[ (Pass) or ;* (Check)

Verify that the software does not contain the desired size standard:

1. In the Samples tab of the GeneMapper window, note the name
of the size standard assigned to the affected sample.

2. Click & (Tools » GeneMapper Manager).
3. In the GeneMapper Manager, select the Size Standards tab.

4. Verify that the Size Standard tab does not list the missing size
standard, or that it has not been renamed.

Symptom

SNF PQV displays
(Check)

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide

Possible Cause Solution

(Autoanalysis only) The size Do one of the following:

standard may have been set
incorrectly in the plate record of the
Data Collection Software.

If using an Applied Biosystems
size standard, click Import to
import the definition from the
The size standard definition has been default Panels folder.

renamed, deleted, or does not exist. | e Click New to create a custom
size standard of the same name.
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SP (Split Peak)

SP (Split Peak)

Description/
Function

Expected Values

Troubleshooting

The SP PQV indicates that the peak for the associated genotype is
part of a pair of overlapping peaks that are less than 0.25 base pairs
apart (the horizontal distance between two peak apexes).

[ (Pass) or ;* (Check)

Select the affected genotype, click [ (Analysis » Display Plots),
then review the peak at the appropriate location.

SPA (Single Peak Artifact)

Description/
Function

Expected Values

Troubleshooting

The SPA PQV indicates that no peaks are present within a two-base-
pair range before the peak for the associated genotype. This PQV is
designed to detect the absence of stutter peaks that accompany
microsatellite peaks.

[ (Pass) or ;* (Check)

Select the affected genotype, click [ (Analysis » Display Plots),
then review the peak at the appropriate location.

Symptom

SPA PQV displays
(Check)

Possible Cause Solution

. The GeneMapper Software did not . In the Panel Manager, edit the

detect any stutter peaks to the left of | marker minimum fragment length,
the allele peak because the then reanalyze.

minimum fragment length for the

marker was set too high.

24

GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide



Chapter 1 Process Quality Values and Basic Troubleshooting
SPU (Spectral Pull-Up)

SPU (Spectral Pull-Up)

Description/
Function

Expected Values

Troubleshooting

The SPU PQYV indicates that the apex of the peak for the associated
genotype is at a position where the marker signal contains pull-up
peaks (also called bleed-through peaks). Pull-up peaks occur when
the peak height of the called allele is less than X% of the larger peak
that is within +1 data point.

[ (Pass) or ;* (Check)

Select the affected genotype, click [ii] (Analysis » Display Plots),
then review the peak at the appropriate location.

SQ (Sizing Quality)

Description/
Function

Expected Values

The SQ PQYV reports the result of the Sizing Quality test, which gauges
the similarity between the fragment pattern defined by the size
standard definition, and the actual distribution of size standard peaks in
the sample data. The metric of the Sizing Quality test is a combination
of several values which measure the success of the algorithms that:

+ Identify and eliminate primer peaks based on peak shape

* Perform size matching (ratio matching)

* Make a size-calling curve using the chosen sizing method
The Sizing Quality metric yields a value between 0 and 1. Based on the
PQV Threshold settings in the analysis method used to analyze the

data, the software translates the metric into the [ (Pass), ;/* (Check),
or @ (Low Quality) flags to indicate the result of the test.

Note: The GeneMapper Software does not complete the analysis of
samples that fail the Sizing Quality test (samples that display @@).

¥ (Pass), ; (Check), or @@ (Low Quality)

Note: When performing size calling using the Classic sizing method,
the software cannot determine Sizing Quality and, therefore, SQ is
always ;* (Check).
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SQ (Sizing Quality)

Troubleshooting Review the data of the size standards that failed the SQ PQV:

1.

In the Samples tab of the GeneMapper window, click @&
(Analysis » Low Quality to Top) to sort the data so that the
samples that produced errors appear at the top of the table.

In the Samples tab, select the rows for the sample(s) that display
(Check) or @ (Fail) in the SQ column.

Click [l (Analysis » Size Match Editor) to view the sizing
information for the selected sample(s).

In the Navigation Pane of the Size Match Editor, select a sample
file to display the sizing data for the associated sample.

Review the data for the following qualities:

+ Signal Strength — The signal strength (peak height) of all
peaks must exceed the Peak Detection Threshold defined in
the analysis method used to analyze the data.

* Correct Size Calls/Labels — All peaks must be correctly
identified by the software. The labels above the peaks must
be in sequential order from left to right, least to greatest.

» Evenness of Signal Strength — All peaks should have
relatively uniform signal strengths.

* Sizing Quality — The sizing quality of each sample should
be within the passing range for your chemistry application.

Note: To magnify the plot of the Size Matches tab, drag the
mouse cursor (-4 ) across a region of the x- or y-axis.

Use Table 1-4 on page 27 to determine an appropriate corrective
action.

Repeat steps 4 through 6 for each sample file.
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Table 1-4 SQ PQV Troubleshooting

Symptom

Possible Cause

SQ (Sizing Quality)

Solution

* SQPQV displays ;% or @@
¢ Size Match Editor does not

The Size Standard Dye setting for
the size standard definition is not
set to the correct dye.

¢ SQ PQV displays

e Peaks do not contain size
labels

display peak data
or @

The fragment sizes of the size
standard definition do not match
the positions of the detected
peaks.

1. Verify that the correct size
standard definition is in use.

2. Open the size standard
definition and verify that the:

— Dye setting is set to the
correct dye

— Fragment sizes are correct

3. Modify the size standard
definition as necessary.

* SQPQV displays ;% or @@
¢ One or more miscalled peaks
* SQPQV displays ;% or @
¢ Peaks are clear and

distinguishable, but have
low signal strength

Peak detection threshold
associated with the size standard
is set too high or low.

Peak detection threshold
associated with the size standard
is set too high or low.

Electrophoresis or pipetting error

Adjust the analysis method so
that the peak detection threshold
associated with the size standard
is greater than the height of the
miscalled peak. See “Adjusting
Peak Detection Thresholds” on
page 29 for more information.

* SQPQV displays ;% or @)

e Size standard peaks occur
within a primer peak

Insufficient cleanup step

Create and analyze the data
using a custom size standard
that does not include the
undetectable peak. See
“Correcting Miscalled Peaks” on
page 28 for more information.

* SQPQV displays ;% or @@

¢ Size standard peaks are clear
and distinguishable, but
consistently have low signal
strength

Incorrect concentration of size
standard in sample loading
reagent

Incorrect injection settings

Increase the concentration of
size standard added to
subsequent runs.

Review the injection settings of
the run module for errors.

* SQPQV displays ;% or @@

¢ Peaks are clear and
distinguishable, but have
low signal strength

¢ Sizing failures occur in a
regular pattern (the same

¢ Electrophoresis or pipetting
error

e Defective capillaries/arrays

¢ SQ PQV displays

e Size calling errors occur for
different samples on the same
capillary over multiple runs

wells fail repeatedly)
or @

Defective capillary

See the user manual for your
Applied Biosystems
electrophoresis instrument for
information on troubleshooting
defective capillaries/arrays.
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SQ (Sizing Quality)

Correcting  You can use the Size Match Editor to correct peaks that are miscalled
Miscalled Peaks by the GeneMapper Software.

To correct a miscalled size standard:

1. In the Navigation Pane of the Size Match Editor, select the
sample file containing the miscalled peak.

2. Remove the label from the miscalled peak:

a. Select the peak with the label by clicking inside the body of
the peak.

b. Select Edit » Delete Size Label (or right-click the peak,
then select Delete).

3. Apply the label to the correct peak:
a. Select the correct peak.

b. Select Edit » Add Size Label (or right-click the peak, then
select Add).

c. In the Select Size dialog box, double-click the label to
apply to the selected peak.

4. Click & (Tools » Check Sizing Quality) to verify that the
sample sizes correctly.

5. Click Apply to save the changes, then click OK.

IMPORTANT! You must click Apply to reanalyze the sample.

Note: Observe that the cell in the Status column for the sample
now displays & (Analysis Required).

6. Reanalyze the sample using the new setting to verify that the
problem is resolved.
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SQ (Sizing Quality)

Adjusting Peak You can resolve a significant number of sizing failures by adjusting
Detection the peak detection thresholds of the analysis method for a project.

Thresholds The software identifies peaks that exceed the threshold for each
associated dye channel, but it cannot identify peaks that fall below it.
Samples that exhibit low signal intensity (low peak heights) can
occasionally fail sizing because one or more peaks fall below the
threshold defined in the analysis method. By lowering the threshold
of the appropriate dye channel, the software can call the peak(s)
correctly.

In contrast, when the signals of the size standard peaks are very high,
the software may misidentify a shoulder preceding a peak as the main
peak (see Figure 1-2). Because the shoulder peak does not occur at
the correct position relative to the other peaks, sizing fails. By
adjusting the analysis method so that the threshold value is greater
than the height of the shoulder, you can achieve good sizing.

=
Fie Edt View Took
Size Matches | Sie Caling Curvs |
25
25-bp shoulder
| incorrectly labeled
“‘030 930 970 330 M0 103 asa peak

1] - )2 |ET | ;I{

Figure 1-2  Size standard with shoulder incorrectly labeled as a peak

To lower the peak detection thresholds of an analysis method:

1. In the GeneMapper window, click [E (Tools » GeneMapper
Manager).

2. In the GeneMapper Manager, select the Analysis Methods tab.
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SQ (Sizing Quality)

3. Do one of the following, to:
Modify the current analysis method, go to step 4.
Create a copy of the current analysis method:
a. Select the current analysis method.
b. Click Save As.

c. Inthe Save As dialog box, type a name for the new method,
then click OK.

Select the analysis method you want to modify, then click Open.
In the Analysis Method Editor, select the Peak Detector tab.

6. Modify the appropriate Peak Amplitude Threshold settings as
needed. Ideally, you should set the threshold of the appropriate
dye channel to a value less than the signal intensity of the
shortest size standard peak.

Note: Applied Biosystems recommends using Peak Amplitude
Threshold settings of no less than 50 RFU.

Analysts Method Editor - AFLP £

Genersl | Alele [Pook Defncior || Pesk Gualty | Qualty Fisgs |

Peak Detection Algorithn: [dvanced

Peak Detection
= 5 2 Peak Amplitude Thresholds:
Snoothing & Noem
:m B: ISD R: ISD )

e | e e Peak Amplitude
Ep— Threshold settings
T 2nd Orcee Loast Soumns ¥: I5U o: ISD

» e Squres

:; mmm ¥ Enable Hormalzation

™ Gobal Southem Methad m:‘mm

Fermsization oy,
Factory Defats
o Cancel I

7. Click OK to save the analysis method.

8. Click Done to close the GeneMapper Manager, then reanalyze
the samples using the new analysis method.
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SQ (Sizing Quality)

Customizing a You can create a custom size standard definition to correct some
Size Standard problems that consistently cause samples to fail sizing. Examples of
Definition problems that you can resolve using custom size standards include a
series of samples that fail sizing because:
» The primer peak prevents the software from detecting and sizing
the peaks of the smaller size standard fragments

1} 1000 2000 3000 4000 5000 E000

il L

Size standard peaks
eclipsed by the primer peak

Primer peak

* A fragment of a custom size standard does not migrate as expected
during electrophoresis

About GeneMapper Software Size Standards

Before the GeneMapper Software can size fragment analysis data, it
must contain information about the size standard that was run with
the samples. The size standard definition supplies the software with
two pieces of information: the color of the dye associated with the
size standard, and the sizes (in bp) of the fragments that comprise the
size standard. Although the software provides definitions for all
Applied Biosystems size standards, you may need to create your own
definition if you choose to use a third-party standard, or experience
difficulty analyzing your data.

To create a custom size standard definition:

1. In the GeneMapper window, click [E (Tools » GeneMapper
Manager).

In the GeneMapper Manager, select the Size Standards tab.
Click New.

In the Select Dye and Analysis Method dialog box, select Basic
or Advanced, then click OK.
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XTLK (Cross Talk)

5. In the Size Standard Editor:
a. In the Name field, type a name for the custom standard.
b. Select Size Standard Dye » <appropriate dye>.

c. In the Size Standard table, type the size values for the size
standard (press Enter after typing each value).

IMPORTANT! After typing the last value, you must press Enter
to ensure the final value is included in the definition.

IMPORTANT! The values for the Analysis Range and Sizing
Range defined in the Allele and Peak Detector tabs of the
analysis method must match the peak range defined by the
associated size standard.

6. Click OK to save the size standard.
7. Click Done to close the GeneMapper Manager.

8. In the Samples tab of the GeneMapper window, apply the new
size standard to the samples of the project.

9. Reanalyze the sample using the new setting to verify that the
problem has been resolved.

XTLK (Cross Talk)

Description/
Function

Expected Values

32

The XTLK PQV indicates that, at the peak position of the associated
genotype, the ratio of the signals collected from the neighboring
capillaries exceed the Cross-talk ratio setting in the Peak Quality tab
of the analysis method.

Note: When the XTLK PQYV is triggered, the software reduces the
GQ PQV by 50% (the default multiplier is “0.5).

[ (Pass) or ;% (Check)
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You can use tools in the GeneMapper® Software to identify potential
problems at both the project and study levels of the SNPlex"™ System
analysis.

Identifying Potential Problems in SNPlex System Studies

Version 4.1 of the GeneMapper Software emphasizes the use of
studies for analyzing data generated using the SNPlex'" Genotyping
System Chemistries. You can use the tools of the Study Manager to
maintain system-wide quality control and visualize potential
problems in SNPlex System data. After you identify a potential
problem, the software allows you to review the applicable run and
resolve the issues that can be corrected.

Note: See the GeneMapper® Sofiware Version 4.1 SNPlex™ System
Analysis Getting Started Guide (PN 4403617) for a detailed
explanation of the study management system.

Identifying Potential Problems in SNPlex Projects

SNPIex projects, like the other analyses supported by the
GeneMapper Software, contain a variety of Process Quality Values
(PQVs), which can aid you in identifying potential problems.
Chapter 1 explains the functions of all PQVs relevant to the analysis
of SNPlex System data.

The SNPlex™ Genotyping System 48-Plex User Guide (PN 4360856)
describes how to resolve common chemistry- and software-related
problems. The user guide addresses all aspects of the SNPlex
System, not just those issues that are exclusive to the GeneMapper
Software analysis.
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Genotyping Algorithms

Overview This chapter discusses the following algorithms:
* Peak Detection — Uses the Basic, Advanced, or Classic mode
algorithms to detect peaks and process data
+ Size-Matching/Calling — Matches detected peaks to size standards
* Binning — Determines bin centers for genotyping

* Allele-Calling — Produces a consensus call based on several allele-
calling algorithms

Data Flow Figure 3-3 and Figure 3-4 on page 37 show the data flow in
GeneMapper® Software. Standard signal processing is applied to the
data before the data are delivered to the GeneMapper Software
algorithms.

‘ Input Sample ‘

v

Supported Applied Biosystems
Genetic Analysis Systems

v

‘ Baselining ‘

v

‘ Peak Detection ‘

‘ Bin;ing ‘
v

‘ Size-Matching/Calling ‘

Cowe | (][] [ [ ]

‘ Arbitrator ‘

|
v

‘ Bin Assignment ‘

v
‘ Final Quality Value Determination ‘
|

v
‘ Report Results to User ‘

Figure 3-3 Microsatellite analysis data flow
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‘ Input Sample ‘

Supported Applied Biosystems
Genetic Analysis Systems

v

‘ Baselining ‘

v
‘ Peak Detection ‘

|
) 4

‘ Binning ‘
v
| Size-Matching/Calling |

v

‘ Allele Calling ‘
v

‘ Final Quality Value Determination ‘

I
h 4

‘ Report Results to User ‘

Figure 3-4 SNPlex™ System analysis data flow
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Degree and Peak
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Window Size
Parameters

Two peak-detection parameters are used in the polynomial detection
algorithm: Polynomial Degree, and Peak Window Size.

Use the Polynomial Degree and the Peak Window Size settings to
adjust the sensitivity of the peak detection. You can adjust these
parameters to detect a single base pair difference while minimizing
the detection of shoulder effects or noise.

Sensitivity increases with larger polynomial degree values and
smaller window size values. Conversely, sensitivity decreases with
smaller polynomial degree values and larger window size values.

How They Work

The peak window size functions with the polynomial degree to set
the sensitivity of peak detection. The peak detector calculates the first
derivative of a polynomial curve fitted to the data within a window
that is centered on each data point in the analysis range.

Using curves with larger polynomial degree values allows the curve
to more closely approximate the signal and, therefore, the peak
detector captures more peak structure in the electropherogram.

The peak window size sets the width (in data points) of the window
to which the polynomial curve is fitted to data. Higher peak window
size values smooth out the polynomial curve, which limits the
structure being detected. Smaller window size values allow a curve to
better fit the underlying data.

How to Use the Peak Detection Parameters

Use the table below to adjust the sensitivity of detection.

Function Polynomial Degree Value | Window Size Value
Increase sensitivity Higher Lower
Decrease sensitivity Lower Higher
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To detect well-isolated, baseline-resolved peaks, use polynomial degree
values of 2 or 3. For finer control, use a degree value of 4 or greater.

As a guideline, set the peak window size (in data points) to be about 1
to 2 times the full width at half maximum height of the peaks that you
want to detect.

To examine how GeneMapper Software has defined a peak, select
View » Show Peak Positions. The peak positions, including the
beginning, apex, and end of each peak, are tick-marked in the
electropherogram.

Figure 3-5 shows peaks detected with a window size of 15 data
points and a polynomial curve of degree 2 (green), 3 (red), and 4
(black). The diamonds represent a detected peak using the respective
polynomial curves.

Note that the smaller trailing peak is not detected using a degree of 2
(green). As the peak detection window is applied to each data point
across the displayed region, a polynomial curve of degree 2 could not
be fitted to the underlying data to detect its structure.

2000 -

Polynomial curve of degree 4
1500 (black)

Polynomial curve of degree 3
(red)

1000 -
Polynomial curve of degree 2\

(green)

500

il 1 I 1 1 I

Figure 3-5 Electropherogram showing peaks detected with three
different polynomial degrees
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Effects of
Increasing the
Window Size
Value

In Figure 3-6 both polynomial curves have a degree of 3 and the
window size value was increased from 15 (red) to 31(black) data
points.

As the cubic polynomial is stretched to fit the data in the larger
window size, the polynomial curve becomes smoother. Note that the
structure of the smaller trailing peak is no longer detected as a
distinct peak from the adjacent larger peak to the right.

2000 -

1800

Window size value of 31 (black)

1w Window size value of 15 (red

500

Figure 3-6 Electropherogram showing the same peaks as in the
Figure 3-5 after increasing the window size value but keeping the
polynomial degree the same
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Optimizing Peak Detection Sensitivity

Examples B Example 1: Reducing Window Size. ................... 41
B Example 2: Reducing Window Size/Increasing

Polynomial Degree. .. ........... ... ... 42

B Example 3: Extreme Settings......................... 43

Example 1: Reducing Window Size

Initial  Figure 3-7 shows two resolved alleles of known fragment lengths
Electropherogram  (that differ by one nucleotide) detected as a single peak. The analysis
was performed using a polynomial degree of 3 and a peak window
size of 19 data points.

440 4150 4160 4ITD 4180 4100 4ZD 4RI 4D 4230 4RD 25D 4260 4FTD 420 40 400 410 G20 430 40D 430 4360 A0 400 400 440 441D 4420

a0 |

1500

0 |

Figure 3-7 Electropherogram showing two resolved alleles
detected as a single peak

Note: For information on the tick marks displayed in the
electropherogram, see “Examining Peak Definitions” on page 39.
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Effects of
Reducing

Figure 3-8 shows that both alleles are detected after reanalyzing with
the polynomial degree set to 3 and the window size value decreased
to 15 (from 19) data points.

4140 4160 4180 417D 416D 4100 4200 4210 4220 4230 42D 425D 4260 47D 4R0 4200 400 4000 G20 4T 4D 60 A0 A0 A0 U0 4400 44D 4420

2500 |

100 ]

1000 |

20 |

Figure 3-8 Electropherogram showing the alleles detected as
two peaks after decreasing the window size value

Example 2: Reducing Window Size/Increasing Polynomial Degree

Initial
Electropherogram

42

Figure 3-9 shows an analysis performed using a polynomial degree
of 3 and a peak window size of 19 data points.

GBI 1m0 1sD 1A 186 17D G0 (A0 1B 1M0 120 1330 1040 136D 1360 0GP0 196D 1980 200D ZOMD R0 00 2040

o0 _|

200 |

Figure 3-9 Electropherogram showing four resolved peaks
detected as two peaks
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Figure 3-10 shows the data presented in the figure above re-analyzed
with a window size value of 10 and polynomial degree value of 5.

540 1860 1860 167D 1560 18D 1800 1910 190 1930 1940 1850 1960 17D 19AD 1980 300D 00 a0 030 3040

1600 |

o0 _|

200 |

Figure 3-10 Electropherogram showing all four peaks detected
after reducing the window size value and increasing the
polynomial degree value

Example 3: Extreme Settings

Effects of Extreme
Settings

Figure 3-11 shows the result of an analysis using a peak window size
value set to 10 and a polynomial degree set to 9. These extreme
settings for peak detection caused several peaks to be split and
detected as two separate peaks.

A A A0 4D 60 60 HTD B0 80 400 410 420 430 4140 HB0 4160 A0 4B0 410 40 420 4 4m0

aon_|
o0 |

o0 |

hl
v

o

Figure 3-11 Electropherogram showing the result of an analysis
using extreme setting for peak detection
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Using These
Parameters
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Use the Slope Threshold for Peak Start and Slope Threshold for Peak
End parameters to adjust the start and end points of a peak.

The values assigned to these parameters can be used to better position
the start and end points of an asymmetrical peak, or a poorly resolved
shouldering peak to more accurately reflect the peak position and area.

In general, from left to right, the slope of a peak increases from the
baseline up to the apex. From the apex down to the baseline, the slope
becomes decreasingly negative until it returns to zero at the baseline.

Apex —— o~ — — — — — —
Increasingly Increasingly
positive slope / \ negative slope
(+) (D)
Baseline - — — — — — — U o

If either of the slope values you enter exceeds the slope of the peak
being detected, the software overrides your value and reverts to zero.

* For typical or symmetrical peaks, use a value of zero.

» For asymmetrical peaks, select values other than zero to better
reflect the beginning and end points.

+ A value of zero does not affect the sizing accuracy or precision
of an asymmetrical peak.

Note: The size of a detected peak is the calculated apex between the
start and end points of a peak and does not change based on your settings.

To move the... Then... Example

Start point of a peak
closer to its apex

Change the Slope Threshold for Peak
Start value from zero to a positive
number.

End point of a peak
closer to its apex

Change the Slope Threshold for Peak
End value to a more negative number.
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Slope Threshold Example

Asymmetrical
Peak

Initial Electropherogram

The initial analysis using a value of 0 for both the Slope Threshold
for Peak Start and the Slope Threshold for Peak End produces an
asymmetrical peak with a noticeable tail on the right side.

dap 2160 280 270 2180 2180 mOD 2210 130 30 20 220 0 170 2@0 -0 200 20 20

1200 |

00|

a0 |

1

Figure 3-12 Electropherogram showing an asymmetrical peak

Adjusting Slope Threshold for Peak End

After reanalyzing with a value of —35.0 for the Slope Threshold for
Peak End, the end point that defines the peak moves closer to its
apex, thereby removing the tailing feature. Note that the only change
to tabular data is the area (peak size and height are unchanged).

dap 2160 280 270 2180 2180 mOD 2210 130 30 20 220 0 170 2@0 -0 200 20 20

1200 |

00|

a0 |

Figure 3-13 Electropherogram showing the effect of changing
the slope threshold for peak end
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Size-Matching/Size-Calling Algorithm

flourescence

46

Size-Matching
Size-Calling
Algorithm

Size-Matching
Algorithm
Example

200

o
=]

This algorithm uses a dynamic programming approach that is
efficient (runs in low polynomial time and space) and guarantees an
optimal solution. It first matches a list of peaks from the
electropherogram to a list of fragment sizes from the size standard. It
then derives quality values statistically by examining the similarity
between the theoretical and actual distance between the fragments.

Figure 3-14 shows an example of how the size-matching/calling
algorithm works using contaminated GeneScan'" 120 size standard
data.

Detected peaks (standard and contamination) are indicated by blue
lower bars along the x-axis. The size standard fragments as
determined by the algorithm (and their corresponding lengths in base
pairs) are designated by the upper green bars. Note that there are
more peaks than size standard locations because the standard was
purposely contaminated to test the algorithm. The algorithm correctly
identifies all the size standard peaks and removes the contamination
peaks (indicated by the black triangles) from consideration. The large
peak is excluded from the candidate list by a filter that identifies the
peak as being atypical with respect to the other peaks.

Bars indicate size standard determined by algorithm

Bars indicate detected peaks

15

20

25

35

L v v V. v i
| I | I | | I il<=—T—1 1 |

110
120

50
62
80

400 800 1200 1600
scan line

Figure 3-14 Size-matching example
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Size-Calling Methods (Classic and Advanced Modes)

Types of Size  The GeneMapper Software provides the following size calling methods:

Calling Methods B Least Squares Method (2nd- and 3rd-Order)............. 47
B Cubic Spline Interpolation Method . ................... 49
B Local Southern Method .. .......... ... ... ... .. .. ... 50
B Global Southern Method . ......... ... .. ... ... ..... 52

Least Squares Method

Overview Both Least Squares methods (2nd-Order and 3rd-Order) use
regression analysis to build a best-fit size calling curve. This curve
compensates for any fragments that may run anomalously.
Consequently, this method typically results in the least amount of
deviation for all the fragments, including the size standards and the
samples.

Depending on whether you choose the 2nd- or 3rd-Order Least
Squares Method in the Analysis Parameters dialog box, the resulting
size curve is either a quadratic or a cubic function. The software uses
the known standard fragments and the associated data points to
produce a sizing curve based on Multiple Linear Regression.

Advantages Figures 3-15 and 3-16 on page 48 show that in nearly all instances
the mobility of an individual DNA fragment is coincident with the
best curve fit of the entire data set. Stated differently, the mobility of
most DNA fragments is strictly length dependent. This method
automatically compensates for fragments that run anomalously.

The GeneMapper Software calculates a best-fit least squares curve
for all samples, regardless of the size-calling method you choose.
The curve is black in the Standard Sizing Curve window.

Note: The graphs in this section were generated using Version 3.5.1
of the GeneScan® Software. The results are similar to those obtained
when you use the GeneMapper Software.
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Best Fit Znd Order Curve

2g0 | A0 =-9.771623E+01
1 41 =+1.220835E-01

42 = -4556885E-06
200 | R°2 = 1.000
280
200 |
150
100
50 |

Size Calling Curwve
o 2nd Order Least Squares
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1000 1800 2000 2500 3000 3500 4000 4500

Figure 3-15 2nd-Order Least Squares size calling curve

Best Fit 3rd Order Curve
ag0 | A0 = -1.266506E+02
T 41 =+1.808974E-01
42 =-2.041442E-05
300 | 43 =+1.887158E-09
R*z=1.000
280
200 |
150
100
50 |
Size Calling Curwve
o 3rd Order Least Squares
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1000 1800 2000 2500 3000 3500 4000 4500

Figure 3-16 3rd-Order Least Squares size calling curve
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Cubic Spline Interpolation Method

Overview The Cubic Spline method forces the sizing curve through all the
known points of the selected size standard. Although this enforcement
produces exact results for the values of the standards themselves, it
does not compensate for standard fragments that may run anomalously.

Best Fit Znd Order Curve
2g0 | A0 =-9.771623E+01

1 41 =+1.220835E-01
42 = -4556885E-06
z00 | R*2 = 1.000

200 |

150

100 |

50

Size Calling Curwve
Cubic Spline Interpolation

T T T T T T T T
1000 1800 2000 2500 3000 3500 4000 4500

Figure 3-17 Cubic Spline Interpolation Method

Possible Local Mobility of any DNA fragment can be affected by its sequence, and
Sizing Inaccuracy by secondary and tertiary structure formation. If any internal size
standard fragment has anomalous mobility, the Cubic Spline method
may exhibit local sizing inaccuracy.

For example, assume that a standard fragment is close in molecular
length to an unknown sample fragment. Assume further that the
standard fragment runs anomalously. The Cubic Spline method
assigns the official value to this standard fragment, even though it
may be slightly incorrect. The size of the unknown fragment is then
likely to be calculated incorrectly as well.

Note: This method does not determine the amount of sizing accuracy
error.
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Local Southern Method

Overview The Local Southern method determines the sizes of fragments by
using the reciprocal relationship between fragment length and
mobility, as described by E. M. Southern (1979).

270 | Best Fit Znd Order Curve
A0 = -1.990206E+02
41 = +2.075795E-01
240 42 = -1 545595F-05
R*2 = 1.000

180 |
150 |

120

30 |

60

Size Calling Curwve
Local Southern Method

30 ]

T T T T T T T T T
1200 1400 1600 1800 2000 2200 2400 2600 2800

Figure 3-18 Local Southern Method

Local Southern The equation attempts to describe the reciprocal relationship between
Method Equation the mobility, m, and the length, L0, of the standard fragments.

L = [c¢/(m-m0)] + LO

How The Local This method, which is similar to the Cubic Spline method, uses the
Southern Method four fragments closest in size to the unknown fragment to determine
Works a best-fit line value. Only the region of the size ladder near the
fragment of unknown length is analyzed.

Note: Size estimates may be inaccurate if any of the standard
fragments run anomalously.
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In the Local Southern method:

» The fitting constants of the curve are calculated for each group
of three neighboring points on the standard. A separate curve is
created for each set of three points.

* A curve is then created by using three standard points (two
points below and one point above the fragment), then a fragment
size is determined.

* Another curve is created by looking at an additional set of three
points (one point below and two points above the fragment),
then another value is assigned.

» The two size values are averaged to determine the unknown
fragment length.
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Global Southern Method

Overview

Global Southern

Method Equations

How the Global

Southern Method

52

Works

This method is similar to the Least Squares method in that it
compensates for standard fragments that may run anomalously. The
method creates a best-fit line through all the available points, and
then uses values on that line to calculate the fragment values.

Best Fit Znd Order Curve
2g0 | A0 =-9.771623E+01

1 41 =+1.220835E-01
42 = -4556885E-06
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50
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Figure 3-19 Global Southern Method

Equation Description

Attempts to describe the reciprocal
relationship between the mobility, m,
and the length, LO, of the standard
fragments.

L = [¢/(m-m0)] + L0

5 The fitting constants LO, m0, and ¢
Zi{Li —[¢/((mi-mO0) +L0)]} are calculated by a least-squares fit
to minimize the left side quantity.

All points in the standard are weighted equally, and the curve is not
constrained to go through any specific point. The software can
analyze a large range of fragment sizes with this method. For best
results, use a standard that brackets all the fragments of interest.
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Allele-Calling Algorithms

Overview Final allele calls are based on a consensus between a variety of
different allele-calling algorithms. Each caller has a different design
philosophy such that it excels in a particular data regime but not in
others. Allele-calling algorithms involve envelope detection,
optimization of parametric models, and rule-based systems.

Types of Allele-  The GeneMapper Software provides following allele-calling methods:
Calling Methods B Microsatellite Analysis Methods . ..................... 54

B SNPIlex™ System Analysis Methods. .. ................ 55

— Rules Genotyping Algorithm (see page 55)
— Model Genotyping Algorithm (see page 56)
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Example Output of

Different Allele-

Calling Algorithms

(a) 1251659_27

Microsatellite Analysis Methods

Figure 3-20 on page 54 shows an example of three different allele-
calling algorithms for 16 samples. User annotations are indicated by the
(red) circles, and allele caller outputs are indicated by the (green, black,
and blue) asterisks. Note that consensus between multiple callers
virtually ensures that the calls are correct. In samples (i) and (p), the
algorithms have not made a call because they determined that the data
are too complex to act on. Here the blue asterisks show the calls
transmitted to the user. Low-quality values are reported because in both
cases the first algorithm did not call, and in (i), the black caller does not
agree with the blue. Despite these conditions, however, the calls are
correct. The low-quality values alert the user to potential problems such
as the spurious peak in (i) and the high background in (p).
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Figure 3-20 The effect of three different allele-calling algorithms
on 16 different samples
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SNPlex™ System Analysis Methods

Overview The GeneMapper Software provides the following allele-calling
methods for SNPlex System Analysis:

B Rules Genotyping Algorithm.................. (see below)
B Model Genotyping Algorithm .. ...................... 56

Rules Genotyping The Rules (Maximum-Likelihood or ML) SNP genotyping algorithm
Algorithm  consists of several processes: genotype cluster identification, sample
cluster classification, and confidence value assignment.

<Input: Allele 1 and 2 Intensities>
v

Allele Intensity Correction

v

l v

Resampling Estimate Model Parameters
(Exclude Outliers) ¢ Number of clusters
py e Mean, variance of each cluster
e Allele frequency
Detect Outliers v

Compute Most Likely Genotype
T— and Confidence Values
First Pass ¢ Outlier probability

v
Output: Genotypes and
Quality Values for all Points Second Pass
and Plate Score (optional)

< Filter Samples and Recluster> Second Pass

¢ D

Figure 3-21 Rules algorithm block diagram

Because of small systematic differences in assay performance
between the alleles in a SNP, fixed classification boundaries between
the clusters do not give accurate results for most, if not all, current
SNP detection platforms. Clustering, like all calibration methods, can
correct for systematic errors, but not random errors. Random errors
are estimated and assigned appropriate p-values.
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Model Genotyping

56

Algorithm

Genotype Cluster Identification

The cluster identification stage uses a priori knowledge of the
intensity relationship and frequency distribution of SNP alleles to
construct a most likely model of the SNP assays generating in a given
data set. Systematic parameters such as allele assay strength and
other chemistry factors are estimated. If the most likely model fit is
too poor, the entire data set is rejected.

Sample Cluster Classification and Confidence Value Assignment

The best fit model is used to classify each point into its most likely
class, or genotype. The likelihood of class membership (genotype)
can be derived in the same step.

Post Processing, Filtering, and Reiterations

Genotype and sample filters, bootstrap resampling, and several
reiterations are used to ensure the accuracy of the model fit and
classifications.

The Model genotyping algorithm consists of several processes:
normalization, allele calling, and confidence value generation.

Normalization

Normalization is a run-based algorithm that removes systematic
variation of peak height by allele and sample. This process is
accomplished by comparing the data to a model in which the sum of
allele peaks for any given sample is a constant. Over many repeated
measurements of a given sample or allele, systematic variations from
this a priori model can be quantified and later removed. In the
process of normalization, an overall scale factor can be selected,
which can be set to one. This utility is demonstrated in Figure 3-22
on page 57 where the output from 20 runs can be overlaid to
understand the random, as opposed to systematic, behavior of
signals. For each run 2 e 48 « 96 = 9216 measurements were
normalized with 193 parameters, or approximately one parameter for
each 48 measurements.
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o5l

0 05 15

Figure 3-22 Pre- and post- normalization data. Shown are 80,000
measurements of SNPlex System data overlaid in normalized allele
coordinates. In the left plot, data are normalized only by run. In the
right, the data are fully normalized by sample and allele.

Genotyping

The random error remaining in the data after normalization is relatively
small when compared with the separation of the genotype coordinates,
as seen in Figure 3-23. Each measurement is assigned the genotype for
which it has the highest probability.

Allele 1
Homozygotes

Heterozygotes

Allele 2
Homozygotes

Figure 3-23 Training data distribution
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Final Genotyping and Confidence Value Assignment

The confidence value is a quantitative estimate of the probability of a
correct call (that is one minus the estimated error rate). This single
parameter can be used to optimize the trade-off between throughput
and accuracy for a particular data set, as shown in Figure 3-24.
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Figure 3-24 Accuracy-throughput trade off
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ABB (Automatic
Bin Builder)

access control list

Admin profile

Admin security
group

Admin User Group

Administrator User

AFLP®

Glossary

The first step in accurate allele assignment. After sample files are
collected, bins are created by the ABB based on the chosen panel
information and successive allele calls from sample file collection.
As each sample file in the collection is processed, the bin definitions
are refined to reflect the actual data.

(See Security Group)

A pre-configured profile that cannot be removed and that has execute
access to all functions. Initially associated with the “admin” user. (A
user must always have an assigned profile.)

A pre-configured security group that cannot be removed. This
security group has been granted all rights to all data, to provide a way
for at least one user to have “admin” access to all data.

A pre-configured user group that cannot be removed and that is
always associated with the Admin security group.

A pre-configured user that cannot be removed and that is always
associated with the Admin user group.

Amplified Fragment Length Polymorphism. A DNA fingerprinting
technique that allows the comparison of the DNA from different
organisms. DNA fragments of varying lengths are created by
cleaving an organism’s DNA with restriction enzymes; a specific
subset of these fragments are amplified and analyzed for comparison
purposes.
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Glossary

Algorithm

All User group

allele

allele call

allele-calling

allelic ladder

analysis method

analysis
parameters

60

A set of ordered steps for solving a problem, such as a mathematical
formula or the instructions in a program. The terms algorithm and
logic are synonymous, where both refer to a sequence of steps to
solve a problem. However, an algorithm is an expression that solves a
complex problem rather than the overall input-process-output logic
of typical business programs.

A user group that contains all users. A user cannot be disassociated
from the user group.

One of two or more alternate forms of a marker or gene.

Reference alleles are all alleles or bins created in a bin set in the
GeneMapper Software. They are denoted by a red cross hatch + in
the Panel Manager.

Project alleles are all alleles detected in sample data in a project in
the GeneMapper Software. They are denoted by a blue asterisk in the
Panel Manager.

Identification of the specific allelic form of a marker.

Identification of alleles based on bin definitions; genotyping;
GeneMapper® Software analysis

A sample of DNA containing most possible alleles for a specific
marker or set of markers. Used to create a sample file that the
GeneMapper Software can use to genotype or make allele calls on
sample data.

Within the GeneMapper Software, you select a Sample Type of
Allelic Ladder for the sample file generated using an allelic ladder.

A collection of user-defined parameters that determine the bin set and
analysis algorithms.

A collection of user-defined settings (including analysis method, size
standard, and panel) that determine the sizing and genotyping
algorithms used by the GeneMapper Software to analyze all sample
files in a project. Also called project settings.
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association

audit event

audit map

audit object

audit record

autopanelizer

bin

bin set

cache

challenge

chromosome

Glossary

Two identifiers combined are said to be associated. A user can be
associated with a user group. A user group associated with a security
group yields a set of data rights.

A single permanent change to one or more attributes of an object.
Includes creating a new instance of an object or deleting an exiting
one.

An object associated with an object type; used to tell the audit
component how to audit an object type.

A collection of data defined by an application. Also referred to as an
object.

The description of a single audit event.

A feature that uses reference data generated by the Primer Focus® kit
to quickly define new SNP markers and bin sets.

Within the GeneMapper Software, a fragment size (bp) or basepair
range and dye color that define an allele within a marker. You create a
bin for each possible allele associated with a marker.

Within the GeneMapper Software, a collection of bins (allele
definitions), typically specific to a set of experimental conditions,
usually an instrument. Bin sets are available inside a kit.

An “in memory” representation of the access control data. The
Admin Tool modifies the data in the cache. When the Admin Tool or
Admin API issues the “save” command, the data in the cache are
written to the data store.

A term from user authentication indicating that the user is asked to
provide identification (typically by entering a password).

A long stretch of coiled strands of DNA and proteins containing
many genes. Human DNA is contained within 23 pairs of
chromosomes.
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Glossary

control

Control Security
Group

data access control

Data group
data rights
database

diploid

dye set

electropherogram

electrophoresis

gene

genome

genotype
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See “positive control” on page 64.

See “negative control” on page 64.

The security group assigned to an Access Control administrative
identifier (user, user group, security group, profile). This security
group is used to determine access by a user to the administrative data
in the Administrative GUI and API.

The part of access control that administers access to user data.

(See Security Group)

Properties that define the type of access a user has to a piece of data.
One form of offline storage.

Having two sets of chromosomes and, therefore, having two alleles
per marker or gene. Human cells (other than egg and sperm cells) are
diploid.

A set of four to five different colored dyes. A specific dye set is used
to label DNA fragments or markers in matrix standards, installation

standards, and chemistry Kkits.

A graphical representation of the intensity (y-axis) of bands produced
in a single gel lane or capillary as a function of time (x-axis).

A technique used to separate molecules by using an electric field to
pass those molecules through a porous matrix.

The basic unit of heredity that carries the genetic information for a
given RNA molecule or protein.

All the DNA contained in an organism or cell, including both the
chromosomes in the nucleus and the DNA in the mitochondria.

The set of allele calls for specific markers or genes within an
organism. (noun)

To determine the allele calls for specific markers or genes within an
organism. (verb)
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haploid

heterozygous
homozygous

installation
standard

kit

LMS

locus

marker

matrix standard

microsatellite

Glossary

Having one set of chromosomes and, therefore, having one allele per
marker or gene. Human egg and sperm cells are haploid.

Having two different alleles for a specific marker or gene.
Having two identical alleles for a specific marker or gene.

A collection of known genetic markers, labeled with dyes from a
specific dye set, used to test the function of a genetic analyzer.

Within the GeneMapper Software, a group of panels.

Linkage Mapping Set; Applied Biosystems chemistry using
dinucleotide repeat microsatellite markers

The chromosomal location of a genetic marker or gene.

A known segment of DNA that has two or more allelic forms. A
marker exists at a known chromosomal loci and can be a gene or a
non-gene. See also microsatellite and SNP.

Within the GeneMapper Software:

A microsatellite marker is defined by a name, fragment size range
(bp), dye color, and repeat length.

A SNaPshot kit analysis marker is defined by a name and fragment
size range (bp).

A collection of known DNA fragments, labeled with four to five
different colored dyes from a specific dye set. The matrix standard is
run on a genetic analyzer and used for spectral calibration of sample
fragments that are run on the same instrument and labeled with the
same dye set.

Microsatellite markers, also known as short tandem repeats (STRs),
are polymorphic DNA loci consisting of a repeated nucleotide
sequence. The repeat sequence can be from 2 to 7 base pairs long.
The number of repeat units varies within a population, thereby
creating multiple alleles for a microsatellite locus.
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Glossary

negative control

panel

phenotype

polymorphism

positive control

primer

primer focus

Primer Focus® kit
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A blank sample that contains no DNA, but all other reagents used in
the experiment. It can indicate if any contamination came from
sample preparation.

In the Sample tab of GeneMapper Software, you select a Sample
Type of Negative Control for the sample file generated from the
negative control. Additionally, in the Panel Manager you define the
negative control when creating markers.

A group of markers. Within the GeneMapper Software, you associate
a panel with a bin set to provide bin definitions for the markers.

The physical manifestation of a genotype.

Differences between organisms’ or individuals’ DNA. Variations of
allele calls.

A sample that contains DNA with known alleles for specific markers.
Its purpose is to verify that the PCR amplification, electrophoresis,
and GeneMapper Software analysis worked correctly.

In the Sample tab of GeneMapper Software, you select a Sample
Type of Positive Control for the sample file generated from the
positive control. Additionally, in the Panel Manager you define the
positive control when creating markers.

A single-stranded piece of DNA or RNA that anneals to a
complementary section of DNA and serves as a starting point for
chain extension by DNA polymerase.

Within the GeneMapper Software, you select a Sample Type of
Primer Focus for the sample file generated using the Primer Focus
kit. The GeneMapper Software uses this file to automatically create
bins using the Auto Panel feature.

An Applied Biosystems kit containing reagents used to create and
amplify all four possible alleles of any SNP marker. The kit allows
you to take advantage of the Auto Panel feature in the GeneMapper
Software to automatically create bins for each allele in a SNaPshot
kit analysis.
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probe

profile

project

project settings
project settings

reference samples

rights

Security group

Security ID

SFNF
silent auditing

size match editor

size standard

Glossary

A DNA or RNA fragment that has been labeled in some way (for
example, fluorescent or radioactive), then used in a molecular
hybridization assay to identify DNA or RNA sequences that are the
same or closely related to it in sequence.

An identifier that gives an administrator the ability to grant or revoke
access to functions.

Within the GeneMapper Software, a collection of sample files and
the analysis parameters for genotyping them.

See “analysis parameters” on page 60.

Parameters set by the user to prepare a project for analysis.

All or a subset of the actual samples. The reference samples typically
contain all of the alleles present in the sample set and are used to
create a bin for each allele within the GeneMapper Software.

Properties that define whether a user has access to data or a function.

An identifier that can be associated with a user group to confer a set
of data rights.

The universal identifier of the security group and the preferred name
of the column in an application table that holds the security group ID.

Sample File Not Found
Automatic audit record creation (without prompting of the user).

A window in GeneMapper® Software that allows users to examine
size-standard electropherograms, edit the identification of size-
standard peaks, and view the size-calling curve.

A collection of DNA fragments of known lengths within a range (for
example, 50 to 400 bp) all tagged with the same dye. The size
standard is co-injected into the genetic analyzer capillary with the
sample, then used to size the sample data. All Applied Biosystems
size standards are labeled with a red or orange dye.
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Glossary

SNaPshot® kit

SNaPshot® System
Multiplex Analysis

SNP

SNP

SNPIlex™ System

66

An Applied Biosystems kit containing reagents used to PCR amplify
any SNP markers, using single-base-extension technology. Sample
files can then be sized and genotyped by using a SNaPshot analysis
in the GeneMapper Software.

Primer extension-based chemistry for SNP validation

Single Nucleotide Polymorphism. A marker consisting of a single
base pair that varies, thereby creating up to four alleles of the marker.
In this document, SNP refers to SNaPshot® system markers and
SNPlex™ systems

Single-Nucleotide Polymorphism (used)

High-throughput assay for genotyping.
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A

ABB (automatic bin builder), definition 59
access control list, definition 59

admin profile, definition 59

admin security group, definition 59

admin user group, definition 59

admin user, definition 59

ADO (Allele Display Overflow) PQV 8
AE (Allele Edit) PQV 8

algorithms
allele-calling 36, 53
binning 36

definition 60

overview 36

peak detection 36

size-matching 36
all user group, definition 60
Allele Display Overflow PQV 8
Allele Edit PQV 8
Allele Number PQV 9
allele-calling

algorithm 53
definition 60
AN (Allele Number) PQV 9
analysis method, definition 60
Applied Biosystems
contacting  viii
customer feedback on documentation  viii
Information Development

department  viii
Technical Support viii

association, definition 61
assumptions for using this guide v
audit event, definition 61

Index

audit map definition 61
audit object, definition 61
audit record, definition 61
autopanelizer, definition 61

B

BD (Broad Peak) PQV 9

BIN (Out of Bin Allele) PQV 10
bold text, when to use v

Broad Peak PQV 9

C

cache, definition 61

CC (Control Concordance) PQV 11
challenge, definition 61

Control Concordance PQV 11
control security group, definition 62

conventions
bold text v
for describing menu commands v
IMPORTANTS! vi
in this guide v
italic text v
Notes vi
user attention words Vi
Cross Talk PQV 32

customer feedback, on Applied Biosystems
documents  viii

D

data access control, definition 62
data flow, genotyping algorithms 36
data group, definition 62
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Index

data rights, definition 62
database, definition 62
documentation, related  vii
Double Peak PQV 12

DP 12

DP (Double Peak) PQV 12

E
EPT data, displaying 5
examining peak definitions 39

example output of different allele-calling
algorithms 54

G

Genotype Quality PQV 13
genotyping algorithms 36

GQ (Genotype Quality) PQV 13

H

help, online, accessing  vii

Information Development department,
contacting  viii
italic text, when to use v

L

LMS, definition 63
Low Peak Height PQV 15
LPH (Low Peak Height) PQV 15

M

Marker Quality 14
Matrix Not Found PQV 16

menu commands, conventions for
describing v
MNF (Matrix Not Found) PQV 16
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MSDSs, obtaining  viii

N

Narrow Bin PQV 18
NB (Narrow Bin) PQV 18
numeric quality metrics, displaying 7

0]

OBA (One Basepair Allele) PQV 18
Offscale PQV 19

One Basepair Allele PQV 18

online help, accessing  vii

optimizing peak detection sensitivity 41
OS (Offscale) PQV 19

Out of Bin Allele PQV 10

Overlap PQV 20

OVL (Overlap) PQV 20

P

peak definitions, examining 39

peak detection 38
effects of extreme settings 43
guidelines for use 39
optimizing sensitivity 41
parameters 38
peak window size 38
polynomial degree 38
slope threshold 44

peak detection sensitivity, reducing window

size 41

Peak Height Ratio PQV 21
PHR (Peak Height Ratio) PQV 21
polynomial degree 38

peak detection 38

varying 39

window size value 40
possible local sizing inaccuracy 49
Process Quality Values (PQV) 2 to 32

displaying as numbers 7
profile, definition 65



project settings, definition 65

R

Raw Data, displaying 5

reducing window size and increasing
polynomial degree 42

rights, definition 65

S
Sample File Not Found PQV 22
sample information, displaying 5
security group, definition 65
security ID, definition 65
SFNF (Sample File Not Found) PQV 22
Sharp Peak PQV 23
SHP (Sharp Peak) PQV 23
silent auditing, definition 65
Single Peak Artifact PQV 24
size calling 53
advanced method 47
classic method 47
cubic spline interpolation method 49
global southern method 52
least square method 47

local southern method 50
overview 47

size match editor, definition 65
Size Standard Not Found PQV 23
size-matching/size-calling algorithm 46
Sizing Quality PQV 25
slope threshold

asymmetrical peak 45

peak end parameters 44
peak start parameters 44

SNaPshot® analysis, definition 66
SNF (Size Standard Not Found) PQV 23
SNP

definition 66
SNPlex™ system analysis, definition 66
SP (Split Peak) PQV 24

SPA (Single Peak Artifact) PQV 24
Spectral Pull-Up PQV 25

Split Peak PQV 24

SPU (Spectral Pull-Up) PQV 25
SQ (Sizing Quality) PQV 25

T

Technical Support, contacting viii
text conventions v
training, information on  viii

U

user attention words, described vi

\'

varying polynomial degree 39

W

window size value, increasing 40

X
XTLK (Cross Talk) PQV 32
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